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Accessing GMS

Step 1: Navigate to the TDEC Grants
Management System (SmartSimple).

Step 2: Enter login credentials and click
“Login”. The My Applications pane will
open upon login.

Tip: If accessing the system for the first
time, you will need to register. Click on
the “Register here” button on the bottom
left corner and see registration tutorial
video for additional support.

Department of
TN Environment &

——— Conservation

TDEC Grants Management System

Welcome to the TDEC Online Grants Management System! We are excited to offer a more streamlined

and easier way to submit applications and grants management for funded projects.

How to Use the System

labeled: Register Here. Once you have registered, you can log on anytime to apply for funding
opportunities, review active grants, view past submissions, and submit reimbursements and reports

for funded projects.

New to the system?

How to Register Tutorial Video

The first step is to register as an individual and affiliate with an organization by clicking the button below

Login
- Step 1 |
Email: Enter Email
Password: Enter Password
Step 2

Forgot Password?

How to Reset Your Password Video Tutorial

To learn more about us click here



https://tdec.smartsimple.com/s_Login.jsp
https://youtu.be/3Bpwj5vVfU0
https://youtu.be/3Bpwj5vVfU0

GMS Procurement Approval

Request Process

TN Depa.rtment of
Environment &
= CONservation



GMS Process for Requesting Procurement Approva

.
Step 1: Once logged in;

p ° gg '
Navigate to the My

. .
A p p I I c a t I o n s ta b a n d Current session: You are logged in as Sunshine, City of, to switch your organization click the Switch Organization button on the top right.
C | i C k t h e Act ive ta b For Grants System Help, contact TDEC.Grants@tn.gov. For application questions, please contact the Grant Program Contact listed in the application.Note: It iz recommendzd to use the Firefax browser while socessing the system for optimal performance,
.

T h e n , i d e n t i fy t h e g ra n t * Submit Affiliation Request [“] How to Affliate Tutorial | Procurement Guidelines ( Change Password
. .
associated with the Pr—— +6 ) By csins :

procurement activity. - e

Material Management - Convenience Center Grant
DWR-ARP Non Collaborative Grants State Water Infrastructure Grants (SWIG) program Sunshine, City of Approved 06/27/2023 03:53PM

Deadline: 07/01/2023

Step 2: Select the

application and click
VIeW to Open the gra nt Material Management - Used Oil Grant ‘m oo S ] ‘ ‘ ‘

..* PENDING (0) O COMPLETED (0)

DWR-ARP Non Collaborative Grants State Water Infrastructure Grants (SWIG) program Sunshine, City of Approved 06/27/2023 03:53PM

O 9 20194854 RES Planning Grant Sunshine, City of Approved 06/13/2023 09:12AM v

CUREMENTS (PENDING) (8
Deadline: 07/01/2023

landing page.

# Application ID % Activity Type % Organization 4 Status £ LastModified ]

Mo matching records found

DWR-ARP Regionalization Grants State Water Infrastructure Grants (SWIG)

Deadline” 08/08/2023




GMS Procurement Process: Manage Projects Tab

Step 3: Navigate to the

Manage Projects tab. The|, ... prp— W}@

L
Projects from the B Noes
a p p | i ca ti O n a re S et a n d Application Status: Approved Application Type: DWR-ARP Collaborative Grants State Water Infrastructure Grants (SWIG) program

ation ID: 2022-8899 ()

Ca n b e S e | e cte d to Sta r't Step 3 You have $25.00 remaining out of $25.00

MANAGE PROCUREMENTS PURPOSE AND OVERVIEW TIMELINE, ELIGIBILITY & FUNDING SELECTION CRITERIA RESOURCES AND CONTACT TITLE VI COMPLIANCE GENERAL INFORMATION BUDGET AND ATTACHMENTS GENERAL PROPOSAL INF! >

the procurement process.

Projects

Procurements can be entered as needed for each project by clicking the Create Procurement button next to the corresponding project.

Step 4: Select a project YR | o . o I
frO m th e e Sta b | I S h e d | I St ’ Ope 1 DWHPA Project 1 Submitted $100,000.00 $0.00 $0.00 $100,000.00
to C re a te a p ro C u re m e nt m 2 WWHPD-1 Waste Water Project 1 Submitted $500,000.00 $0.00 $0.00 $500,000.00
a Ctivity. H it c reate $600,000.00 $0.00 $0.00 $600,000.00
Procurement button. Pp—

(The Procu rement ProjectID = Item or Service Procured = Name of Comp izati ded for ded = P uiD < Activity Type + Status + Budget Amount = Committed Amount + Paid Amount + Remaining Amount +

2022-8899-DWHP-1-

o o -|P-
A l I I I | I i Wi | | m DW-IP-1 Concrete Concrete Co. PRO33566016 Procurement Approved $100,000.00 $0.00 $0.00 $100,000.00
! g | g m WW-PD-1  Water Tower Water Inc. S Procurement  Approved $500,000.00 $0.00 $0.00 $500,000.00

then open on the screen.)

m DW-IP-1 Water Tower Drinking Water Company g%%%gg?ggglp] Procurement  Submitted $12,000.00 $1200n N0

Note: Once a procurement activity is created it will appear at the bottom of this tab




GMS Procurement Process: General Information Tab

Note: In this section, fields
marked with a red asterisk
(*) are required in order to
submit for review.

Step 5: Start by completing
the following items within
the General Information
Tab:

« Actual project type
* |tem or Service Procured

« Description of how
procurement relates to
the project

2022-8267-SW-IPD-1-PR0O34276026 > ® L
GEMERAL INFORMATION  ATTESTATION

~ Procurement Details

Project ID

SW-IPD-1

* Project Type

—Select One— v

* Item or Service Procured

I * Description of how procurement relates to project I

Tip: Be sure to frequently
click “Save Draft” to ensure
progress is not lost

* | this your first procurement associated with the project(s) involved?
O Yes O MNo
* Please select which applies 1o your organization

Note: When the value of the procurement for property or services under a Federal financial assistance award exceeds the SAT, or a lower threshold established by a non-Federal entity (which is $50,000 for the State of Tennessee), formal procurement methods are reguired

The non-Federal entity must have and use documented procurement procedures, consistent with State, local, and tribal laws and regulations and the standards of this section, for the acquisition of property or services required under a Federal award or subaward. The non-Federal entity's documented procurement procedures must conform to the
procurement standards identified in §§ 200.318 through 200.327. Use of the local palicy is ONLY allowable if the rules of said policy are more restrictive in nature compared to those listed in the noted 2 CFR 200 Subpart D regulations

Helpful Hint: If the procurement was performed prior to participation in this grant, please indicate what procurement guidelines you followed.
(O We follow state procurement guidelines
(O We follow federal procurement guidelines

©) ONLY for purchases of 310,000 or less - We follow lacal procurement guidelines

* Please upload your organization's procurement procedures

* What is the effective date or revisions date of your existing procurement policy?

* Select Threshold of Procurement

NEXT »

districis) procurement pelicies are examined for lower formal procureme:
required at a purchasing threshold lower than $50,000, you are required 1o

esheld and additional requirements. If the local policy states a lower thres/
llow your policy. Please select the "$50,000 or the Procurement Policy Reguin

Guidance: The $50,000 threshold is not an exception for Grantees or project ewner to not follow their local purchasing/procurement policies. It is critical that local (city, county or utility
formal procurement, then the acquisition is required to follow the formal procurement process. If the procurement policy states that formal procurement or solicitation procedu




GMS Procurement Process: General Information Tab Cont.

Step 6: Next, complete the
fO”OWing itemS Wlthln the @ wain 2022-8267-SW-IPD-1-PRO34276026 > © d
General Information Tab:

~ Procurement Details

Project ID

SWHPD-1

« Is this your first
procurement associated
with the project(s)
involved?

* Project Type

—Select One— v

* Item or Service Procured

* Description of how procurement relates 1o project

m I * |s this your first procurement associated with the project(s) involved? I

O Yes (O MNo

« Select which applies to
your organization

- Upload your
organization’s
procurement procedures

« What is the effective date
or revisions date of your

existing procurement
policy?

I * Please select which applies to your organization I

Mete: When the value of the procurement for property or services under a Federal financial assistance award exceeds the SAT, or a lower threshold established by a non-Federal entity (which is $50,000 for the State of Tennessee), formal procurement methods are reguired

The non-Federal entity must have and use documented procurement procedures, consistent with State, local, and tribal laws and regulations and the standards of this section, for the acquisition of property or services required under a Federal award or subaward. The non-Federal entity's documented procurement procedures must conferm to the
procurement standards identified in §§ 200.318 through 200.327. Use of the local policy is ONLY allowable if the rules of said policy are more restrictive in nature compared to these listed in the noted 2 CFR 200 Subpart D regulations.

Helpful Hint: If the procurement was performed prior 1o par

ipation in this grant, please indicate what procurement guidelines you followed.
(O We follow state procurement guidelines
ow

(O ONLY for purchases of $10,000 or less - We follow local procurement guidelines

e follow federal procurement guidelines

* Please upload your organization's procurement procedures I

I * What is the effective date or revisions date of your existing procurement policy? I

* Select Threshold of Procurement

NEXT »

Guidance: The $50,000 threshold is not an exception for Grantees or project owmer ta not fol
formal procurement, then the acquisition is reguired 10 follow the formal procurement process.

their local purchasing/procurement policies. It is eritical that Iaual (city, csunty or utility districts) procurement policies are examined for lower formal procurement thresheld and additional requirements. If the local policy states a lower thres/
‘the procurement policy states that formal procurement or g0 3 are required at a purchasing threshold lower than $50,000, you are required 1o follow your policy. Please select the "$50,000 or the Procurement Policy Reguin

I Save Draft |

Submit




GMS Procurement Process: General Information Tab Cont.

Step 7: Continue to P T——" >0 4
complete the mandatory = "
items within the General ’ =
Information Tab - Select : T
Threshold of Procurement. B T e
Depending on selection, a T e
new dropdown of questions « Procurmert Treshold (s = $10.00)
will appear, and additional
tabs will populate specific to —
the procurement threshold.
e e
Tip: If your organizational
procurement procedures e e G s )
indicate a formal procurement
[ s s | somi

process is needed, select the
option “Greater than $50,000
or the Procurement Policy
Requires Formal Solicitation
Process”. 10




GMS Procurement Process: Stages of Procurement

Pre-Bid: In this stage, prior to posting the solicitation, TDEC will review and
confirm all pre-bid documents which includes the Bid or Proposal
supplemental information, advertisement, and procurement policies.

Pre-Award: In this stage, prior to awarding a contract to a vendor, but after
received responses are evaluated, TDEC will review the formal procurement
activity. For projects not yet started, this stage will result in an Authority to
Award (ATA).

Awarded Contract: In this stage, after a contract has been executed, TDEC
will review and provide final approval of the executed contract. Once
approval is received, the grantee may submit reimbursements for the
approved procurement. 11



GMS Procurement Process: Thresholds of Procurement

For additional instructions on completing the procurement activity
associated with the procurement threshold “Less than or equal to $10,000"
see steps 8-11 on slides 13-14

For additional instructions on completing the procurement activity
associated with the procurement threshold “Greater than $10,000 and less
than or equal to $50,000" see steps 12-22 on slides 15-19

For additional instructions on completing the procurement activity
associated with the procurement threshold “Greater than $50,000 or the
Procurement Policy Requires Formal Solicitation Process” see steps 23-
51 on slides 20-35

12



Procurement Threshold (< $10,000): General Information Tab

Ste p 8: |f th e p ro C u re m e nt G Main 2022-8267-SW-IPD-1-PRO34276026
threshold “Less than or ]

[ ]
equal to $10,000" is
selected, enter the
requested details in the
corresponding fields:

> @04

mm/dd/yyyy B
* Select Threshold of Procurement

Guidance: The $50,000 threshold is not an exception for Grantees or project owner to not follow their local purchasing/procurement policies. It is critical that local (city, county or wnility districts) procurement policies are examined for lower formal procurement threshold and additional requirements. If the local policy states a lower threshold for 2
formal procurement, then the acquisition is required 1o follow the formal procurement process. If the procurement policy states that formal procurement or solicitation procedures are required at a purchasing threshokd lower than 350,000, you are required 1o follow your policy. Please select the "350,000 or the Pracurement Policy Requires Formal
Solicitation Process® option below.

I @ Less than or equal 10 $10,000 I

(O Greater than 510,000 and |ess than or equal to $50,000

O Greater than §50,000 or the Procurement Policy Requires Formal Solicitation Process

~ Procurement Threshold (< = $10,000)

« Enter amount of purchase
« Name of Vendor/Supplier

« Upload (IE¥) the required
procurement
documentation

* Enter amount of purchase

* Name of Vender/Supplier

Based on the applicable procurement guidelines, upload the required procurement documentation.
This section is only for purchases below 510,000
Note: Purchase of supplies and services below the small purchase autherity threshold, currently set at 510,000, is not reguired to be solicited competitively. This means that no procurement package is reguired to make purchases less than $10,000 and ne quotes are reguired.

Additional Comments

Comments from Reviewer for General Information Tab (view only)

Tip: Be sure to frequently
click “Save Draft” to ensure
progress is not lost.

NEXT ¥

Save Draft | Submit

13



Procurement Threshold (< $10,000): Attestation Tab

Step 9: Navigate to the
Attestation tab.

G Main 2022-8267-SW-IPD-1-PRO34276026

Project > Activity
Download Form Summary Relevant File(s): n

After inputting the information below please click SAVE DRAFT.

GENERAL INFORMATION ATTESTATION
Antestat

tion items with a * are required 1o be completed before signing and submitting the procurement package for review. If these items are not completed, you will receive an alert that the submission is incomplete.

Step 10: Review and check
off the Attestation to
acknowledge understanding.
Sign and Date accordingly.

Step 11: Click Save Draft
and then click Submit.

~ Procurement Threshold Attestation (< = $10,000)

[ * | confirm this purchase complies with applicable local, state and/or federal pelicies and procedures

* Subrecipient Signature

The input of procurement
details is now complete!

Note: The TDEC team will

review the submission and

provide approval. Once

approval is received, the

grantee may submit

reimbursements for the

approved procurement. 14



Procurement Threshold (>$10,000 or < $50,000):

General Information Tab

Step 12: If the procurement [ 2022:5267-5W1PD-1 PROBAZISN2S
threshold “Greater than  [E. === -
$10,000 and less than or

equal to $50,000" is

selected, enter the
requested details in the
corresponding fields:

« Enter amount of
purchase

« Name of
Vendor/Supplier

« Upload (IE¥) the required
procurement
documentation

> @

S/QUOTES SUMM

EET DEBARMENT S

ATTESTATION

mim/ds

* Select Threshold of Procurement

Guidance: The $50,000 threshold is not an exception for Grantees or project owner 10 not follow their local purchasing/procurement policies. It is critical that local (city, county or utility districts) procurement policies are examined for lower formal procuremen threshold and additional requiremenns. If the local policy states a lower threshold for a

formal procurement, then the acquisition is reguired to follow the formal procurement process. If the procurement policy states that formal procurement or solicitation procedures are required at a purchasing threshold lower than $50,000, you are required to follow your policy. Please select the "$50,000 or the Procurement Policy Reguires Formal
Solicitation Process” option below.

]

() Less than or equal 10 $10,000

v Procurement Threshold (> $10,000 and < = $50,000)

* Enter amount of purchase

* Name of Vendor/Supplier

* Based on the applicable procurement guidelines, upload the required procurement documentation.

Purchasers can use Informal Purchase autherity

saliciting guotes or proposals from at least three (3) vendors when the total value of a contract is expected to be between 510,000 and $50,000. Flease proy

the quotes received
Mote: According to the TM Central Procurement Procedure Manual, informal purchase autharization is approved for purchases less than $50,000.

The grantee should attempt to secure multiple quotes, to the greatest extent possible. If only one quote received, please upload a brief explanation memo with the quote received. If multiple quotes received, please upload each

Additional Comments

Comments from Reviewer for General Information Tab (view only)

NEXT >

[omnori | oome

15



Procurement Threshold (>$10,000 or < $50,000): Bids/Quotes

Summary Worksheet Tab

Step 13: Navigate to the
B i d SIQ uotes s umma ry S Main 2022-8267-SW-IPD-1-PRO34276026
Worksheet Tab. ; T

Step 14: Select the
Bids/Proposals/Quotes
Worksheet button to
open the form in a pop-
up window.

e For engineering procurements ONLY, the price/costs should not be used as an award determining selection factor. The propesals should still include a total cost estimate, even if the contract is Time and Material. The total estimate should be included for each responder in the Bid/Proposals/Quotes Worksheet.

€ BACK

Save Draft Submit

Tip: Be sure to frequently
click “Save Draft” to
ensure progress is not lost

16



Procurement Threshold (>$10,000 or < $50,000): Bids/Quotes

Summary Worksheet Tab Cont.

Step 15: For each bid or quote,
complete the fields on the
worksheet accordingly: 2

« Vendor/Contract Name

https://tdec.smartsimple.com/s_viewxmlpage jsp?fieldid=2001807&codedid=W... A &

o In the Worksheet, to meet the affirmative steps requirement as stated in 2 CFR 200.321, please indicate in the comments of the supplier if
* Ve n d O r/CO ntra Ct Ad d FESS an entity is a diverse business. The intent and purpose of this step is to appropriately document that you are taking the necessary steps to
consider the engagement of diverse businesses. Diverse businesses could be a minority-owned, women-owned, veteran-owned or other
labor surplus area or protected class entity. For guidance, please refer to the Implementation Guidelines, which provides the detailed Go-

° Am O u nt Of Q u Ote ($) DBE posting instructions. The Vendor/Contractor Address should be the physical place of business of the vendor/contractor. The format

should be “City, State — XXXXXX, XX"

o Status

Step 15 | Bids/Quotes Summary Worksheet

Vendor/Contract Name Vendor/Contract Address Amount of Quote (%) Status Comments

« Comments

Step 16: Once all the fields are
completed, click “Save”.

v ] oy

Tip: Click the (+) button to add
extra lines for more bidders.

17



Procurement Threshold (>$10,000 or < $50,000):

Debarment Status Tab

Step 17: Navigate to
the DEba rment Status @ Main 2022-8267-SW-IPD-1-PRO34276026 >0 L
tab. b o . |

After inputting the information below please click SAVE DRAFT.

RKSHEE DEBARMENT STATUS ATTESTATION

o Please verify that YOUR VENDOR or CONTRACTOR is not on the federal debarment list

Any entity receiving TDEC grant funds must provide non-debarment verification if total geods or services for the open contract are equal to or greater than $25,000. Search for your vendor or contractor to confirm that it's not on the Debarment List by going to Systermn for Award Management (SAM]). *

GENERAL INFORMATION BIDS/QUOTES SUMMAR'

Step 18: If your entity
meets the $25,000
threshold, upload (IES)
“Debarment Status
Verification”
documentation.

*Please note, 1o search for a vendor on the SAM.gov site, you need to log in.

Click *SEARCH" tab

h bars type in the Entity name or using an exclusion search term, Unique Entity Identifier (UEI) and/or the Entity Commercial and Government Entity {CAGE) code. You can only use one search bar at a time to search for records. Individuals are not assigned a UEl number or CAGE code. When checking for a
ividual, conduct the search by typing the name in the top bar.

In the searc!
debarred i

Click the magnifying glass button to retrieve a list of results. Entities with "Exclusion” listed in purple are currently debarred, while those labeled "Entity” in green do not have exclusions. In the right upper corner of the webpage, use the Download option and upload a summary of search results.

Upload Debarment Status Verification, If Applicable

If your entity meets the 525,000 threshold, please uplead verification that you are not on the Debarment List.

[J FileName = Size  Date
@ Debarment_Status.docx 11.6KB 07/09/2023 8:21PM

Tatal Files: 1

Comments from Reviewer for Debarment Status Tab (view only)

Tip: Uploaded items will
appear under "File
Name”.

NEXT»

[ oo oo | o |
I Note: /f applicable, read through the “Comments from Reviewer for Debarment Status Tab”

18



Procurement Threshold (>$10,000 or < $50,000): Attestation Tab

Step 19: Navigate to the
Attestation tab.

Step 20: Review and check
off the Attestation to
acknowledge understanding.
Sign and Date accordingly.

Step 21: Click Save Draft
and then click Submit.

The input of procurement
details is now complete!

Note: The TDEC team will
review the submission and
respond with 14 days. Once
approval is received, the
grantee may submit
reimbursements for the
approved procurement.

fl Main

2022-8267-SW-IPD-1-PRO34276026

Project » Activity
Download Form Summary

After inputting the information below please click SAVE DRAFT.

GEMERAL INFORMATION BIDS/QUOTES SUMMARY WORKSHEET DEBARMENT STATUS ATTESTATION

Attestation items with & * are required to be completed before signing and submitting the procurement package for review. If theze items are not completed, you will receive an alert that the submission is incomplete.

~ Procurement Threshold Attestation (> $10,000 and < = $50,000)

[ * I confirm thiz purchase complies with applicable local, state and/or federal policies and procedures

* Subrecipient Signature

* Date

mm/dd/yyyy =]

€ BACK

==

19




Procurement Threshold (>$50,000 or Required): General Information

Tab

Step 22: Select “Greater
than $50,000 or the
Procurement Policy
Requires Formal
Solicitation Process”. The
following tabs will appear:

* Formal Procurement

« Bid/Quotes Worksheet
« Debarment Status

« Attestation

G Main 2022-8267-SW-IPD-1-PR0O34276026 > ®
FCPM_‘._PPOC‘.IPEL'\E\T BIDS/QUOTES SUMMARY WORKSHEET ~ DEBARMENTSTATUS  ATTESTATION

* Is this your first with the praojy involved?

QO Yes O No

* Please select which applies to your organization

Mote: When the value of the procurement for property or services under a Federal financial assistance award exceeds the SAT, or a lower threshold established by a non-Federal entity (which is $50,000 for the State of Tennessee), formal procurement methods are required,

The non-Federal entity must have and use documented procurement procedures, consistent with State, local, and tribal laws and regulations and the standards of this section, for the acquisition of property or services required under & Federal award or subaward. The non-Federal entity's documented procurement procedures must conform ta the
procurement standards identified in §§ 200.318 through 200.327. Use of the local policy is ONLY allowable if the rules of said policy are more restrictive in nature compared to those listed in the noted 2 CFR 200 Subpart D regulations

Helpful Hint: If the procurement was performed prior to parti

pation in this grant, please indicate what procurement guidelines you followed.

(O We follow state procurement guidelines
o]

) OMLY for purchases of 310,000 or less - We follow local procurement guidelines

follow federal procurement guidelines

* Please upload your organization's procurement procedures

* What is the effective date or revisions date of your existing procurement policy?

* Select Threshold of Procurement

Guidance: The $50,000 threshold is not an exception for Gramees or project owner to not follow their local purchasing/procurement policies. It is critical that local (city, county or wility districts) procurement pelicies are examined for lower formal procurement thresheld and additicnal requirements. If the local policy states a lower threshold for &
formal procurement, then the acquisition is reguired to follow the fermal procurement process. If the procurement policy states that formal procurement or solicitation procedures are required at a purchasing threshold lewer than $50,000, you are required to follow your policy. Please select the "$50,000 or the Procurement Policy Reguires Formal
Solicitation Process” option below

(O Less than or equal to $10,000

(O Greater than $10,000 and less than or egual 10 $50,

I@ Greater than $50,000 or the Procurement Policy Requires Formal Solicitation Process I

Additional Comments

Comments from Reviewer for General Information Tab (view only)

NEXT»

== Do

Tip: Be sure to frequently
click “Save Draft” to ensure
progress is not lost.

20



Procurement Threshold (>5$50,000 or Required): Formal

Procurement Tab

Step 23: Navigate to the
Formal Procurement tab

Step 24: Select the stage
the procurement is
currently in, and the
stage(s) already
completed from the list:
« Pre-Bid

* Pre-Award

« Awarded Contract

Tip: Depending upon the
selected stage(s), different
corresponding documents
will need to be uploaded

@} Main

2022-8267-SW-IPD-1-PR0O34276026 >0

Project > Activity
Download Form Summary Relevant File(s): u

After inputting the information below please click SAVE DRAFT.

GENERAL INFORMATION FORMAL PROCUREMENT BIDS/QUOTES SUMMARY WORKSHEET DEBARMENT STATUS ATTESTATION

Helpful Guidelines and Resources

o Stages of Procurement
Pre-Bid is the stage prior 1o posting the solicitation. It is a review stage where TDEC will confirm all pre-bid documents to include the Bid or Proposal package, supplemental information, advertisement and procurement policy.

* Apre-bid review is strongly recomm

approval of procurements more effici
Pre-Award is the stage prior to officially awarding a contract to a vendor, but after evaluations have been made of responses received. This is a required review stage and for projects not yet started, this stage will result in an Authority to Award (ATA)
Awarded Contract is the stage after a contract has been let and it is the final procurement approval that is required for reimbursements to be allowed.

* Select the stage of the procurement you are currently in and the stage(s) you have already completed.
Guidance: Once you have selected the stage(s), please fill out the corresponding sections you have selected below.

[J Pre-Bid
[J Pre-Award

[ Awarded Contract

2




Procurement Threshold (>$50,000 or Required): Pre-Bid Stage

Step 25: Upload (IER) the following
items within the Pre-Bid section:

» Advertisement
« Bid package
« Supplemental conditions

Note: The Pre-Bid section is
mandatory to complete in the Pre-
Bid stage.

The Pre-Award and Awarded
Contract sections are not
mandatory in the Pre-Bid stage,
unless the procurementis in that
stage or that stage has already been
completed.

Additionally, the Bids/Quotes
Summary Worksheet, Debarment
Status, and Attestation tabs are
available but not mandatory in the
Pre-Bid stage.

2t Main GENERAL INFORMATION FORMAL PROCUREMENT BIDS/QUOTES SUMMARY WORKSHEET DEBARMENT STATUS ATTESTATION

v Pre-Bid

* Upload advertisement

The advertizement is the announcement of your request and should be posted to your local paper or local procurement website and posted to Go-DBE website.

* Upload bid package

The bid package should be the solicitation with a clear description of the scope and/or requested services. It should include instructions of how to respond and the evaluation criiteria or bid sheet format.

* Upload supplemental conditions

The supplemental conditions are the additional requirements that a bidder or responder must provide along with their response to the solicitation.

* Have you uploaded all required pre-bid documentation?

O ¥ezs (O Ne

22



Procurement Threshold (>$50,000 or Required): Pre-Bid Stage Cont.

Ste p 26: CO nfi r m a | | re q u i re d GENERAL INFORMATION FORMAL PROCUREMENT BIDS/QUOTES SUMMARY WORKSHEET DEBARMEMNT STATUS ATTESTATION
pre-bid documentation has v Prefid
been uploaded by Selecting * Upload advertisement

Y The advertisement is the announcement of your request and should be posted 1o your local paper or local procurement website and posted to Go-DBE website.
es.

B3

Step 27: Click Save Draft O rietime -

and then click Submit to B Proomme et

send the pre-bid to TDEC for

reVIeW' The g ra ntee WI” The bid package should be the salicitation with 2 clear description of the scope and/or requested services. it should include instructions of how 1o respond and the evaluation criiteria or bid sheet farmat.
receive an email =]

confirmation of submission. O FleNome

&  Procurement_Upload.PNG

* Upload supplemental conditions

The supplemental conditions are the additional requirements that a bidder or responder must provide along with their response to the solicitation.

[  File Name =

B  Procurement_Upload. PNG

* Have you uploaded all required pre-bid documentation?

O Yes (O Mo

XA o [ o]
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Procurement Threshold (>$50,000 or Required): Pre-Award Stage

Step 28: Once TDEC has
completed the initial
review of the formal
procurement activity, the [zozes, > @
Procurement Status ANAGE PROCUREMENTS || PURPOSE AND OVERVIEW  TIMELINE ELIGIBILITY & FUNDING ~ SELECTION CRITERIA  RESOURCES AND CONTACT  TITLEWI COMPLIANCE  GENERAL INFORMATION  BUDGET AND ATTACHMENTS  GENERAL PROPOSALINFO  PARTNER INFORMATION  INFRA
changes to “Pre-Award”.

or Service Procured % Name of Organization R ded for Awarded % Procurement uID + ActivityType ¢ Status *  BudgetAmount : Committed Amount * PaidAmount &  Remaining Amount &
Th e G ra ntee Wi | | rece ive a |m DWAP-1 2022-8899-DW-IP-1-PRO34198440 I Procurement $0.00 $0.00

m WW-PDC-1 2022-8899-WW-PDC-1-PRO34211224 Procurement Draft 50.00 $0.00

confirmation of status
change via email.

Step 29: Navigate to the
Manage Projects and
the Procurements
section. Identify the in-
progress procurement by
the Procurement UID.
Click Open.
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Procurement Threshold (>$50,000 or Required): Pre-Award Stage

Cont.

Step 30: If the project
has passed, or has

completed the Pre-Bid | . h
stage, and is in the Pre-

Award stage, select
both boxes.

GENERAL INFORMATION BIDS/QUOTES SUMMARY WORKSHEET DEBARMENT STATUS ATTESTATION

Helpful Guidelines and Resources

o Stages of Procurement

Pre-Bid is the stage prior 1o posting the solicitation. It is a review stage where TDEC will confirm all pre-bid documents 1o include the Bid or Proposal package, supplemental information, advertisement and procurement policy

» A pre-bid review is strongly recommended for projects that have not been procured. The pre-bid review will examine local purchasing/procurement policies, review the Request for Quote (er Bid or Proposal), and review the requirements of the procurement and the supplemental conditions. The
pre-bid review will assist with making the approval of procurements mare efficient and streamlined.

Pre-Award is the stage prier to officially awarding a contract to a vendor, but after evaluations have been made of responses received. This is a required review stage and for projects not yet started, this stage will result in an Authority to Award (ATA)
Awarded Contract is the stage after a contract has been let and it is the final procurement approval that is reguired for reimbursements to be allowed.

* Select the stage of the procurement you are currently in and the stage(s) you have already completed.
Guidance: Once you have selected the stage(s), please fill out the corresponding sections you have selected below.

Pre-Bid
Pre-Award

[0 Awarded Contract

Tip: Be sure to frequently
click “Save Draft” to
ensure progress is not lost
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Procurement Threshold (>550,000 or Required): Pre-Award Stage

Cont.

Step 31: Upload (g9) the

. . e GENERAL INFORMATION FORMAL PROCUREMENT BIDS/QUOTES SUMMARY WORKSHEET DEBARMENT STATUS ATTESTATION > @
following items within the o]
Pre-Award section: l |
Addenda/extensions issued

solicitations are adjusted, or additional information is provided o potential bidders, addendums are often required to be posted/issued. This should be a part of the procurement file

« Addenda/extensionsissued

« Copies of correspondence with
the bidder

« Documentation regarding the
posting of the solicitation*

* Independent Cost Estimate*

« Certified Bid Tabulation
Evaluation Criteria*®

« Copies of responses to the
solicitation*®

Complete the following fields:
e Costof Procurement*

« Name of Company/ Organization
Recommended for Award*

n i
il
5

Icupies of correspondence with the bidder I

Copies the Grantee's communication with the bidders, i.e., Q&As, any communication regarding pricing and terms, and any best and final offers (BAFO) requested

I * Documentation regarding the posting of the solicitation I

& procurement to be full and open, the solicitation must be made available to an sdequate number of bidders. The solicitation should be advertised on the agency's website or in a newspaper and, as described in this guide, on the Go-DBE website. The effective date to follow the Go-DBE posting
entis January 31, 2023 The requirement of posting on the Go-DBE website is intended 1o ensure that the affirmative steps of 2 CFR 200321 are followed

I“ Independent Cost Estimate I

Grantees must prepare & cost estimate of the costs of goods or services before they receive the bids from the vendors 1o assess the reasonableness of the proposals received.

* Certified Bid Tabulation and Evaluation Criteria I

Grantees must have a formal set of criteria to score proposals received systematically. The Bid Tabulation should calculate and document how the bidders were evaluated

I‘ Copies of responses to the solicitation I

All of the proposals submitted are required o be provided as proof of muttiple vendor responses

I* Cost of Procurement I

The Cost of Procurement should be an accurate estimate of what will be reimbursed in the future for this item or service. This amount should agree 10 the approved SWIG reimbursed amount for the project.

Note: In this section, fields
marked with a red asterisk (%)
are required in order to submit

I‘ Name of Company/Organization Recommended for Awarded I

€ BACK

Step 32 . SaveDraft  Submit

NEXT »

for review
Step 32: Click Save Draft. 26




Procurement Threshold (>$50,000 or Required): Bids/Quotes

Summary Worksheet Tab

Step 33: Navigate to the
BidSIQUOtes summary G Main 2022-8267-SW-IPD-1-PRO34276026
Worksheet Tab. ;

Step 34: Select the
Bids/Proposals/Quotes
Worksheet button to
open the form in a pop-
up window.

wvant File(s): n

Mote: For engineering procurements ONLY, the price/costs should not be used as an award determining selection factor. The proposals should still include a total cost estimate, even if the contract is Time and Material. The total estimate should be included for each responder in the Bid/Proposals/Quotes Worksheet.

* Complete the worksheet below with information for all bids/quotes for this procurement activity.

€ BACK

Save Draft Submit

Tip: Be sure to frequently
click “Save Draft” to
ensure progress is not lost
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Procurement Threshold (>$50,000 or Required) Bids/Quotes

Summary Worksheet Tab Cont.

Step 35: For each bid or quote,
complete the fields on the
worksheet accordingly: 2

« Vendor/Contract Name

https://tdec.smartsimple.com/s_viewxmlpage jsp?fieldid=2001807&codedid=W... A &

o In the Worksheet, to meet the affirmative steps requirement as stated in 2 CFR 200.321, please indicate in the comments of the supplier if
* Ve n d O r/CO ntra Ct Ad d FESS an entity is a diverse business. The intent and purpose of this step is to appropriately document that you are taking the necessary steps to
consider the engagement of diverse businesses. Diverse businesses could be a minority-owned, women-owned, veteran-owned or other
labor surplus area or protected class entity. For guidance, please refer to the Implementation Guidelines, which provides the detailed Go-

° Am O u nt Of Q u Ote ($) DBE posting instructions. The Vendor/Contractor Address should be the physical place of business of the vendor/contractor. The format

should be “City, State — XXXXXX, XX"

o Status

Step 35 ||l Bids/Quotes Summary Worksheet

Vendor/Contract Name Vendor/Contract Address Amount of Quote (%) Status Comments

« Comments

Step 36: Once all the fields are
completed, click “Save”.

Step 36
=

Tip: As necessary, click the (+)
button to add extra lines
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Procurement Threshold (>$50,000 or Required): Debarment Status

Tab

Step 37: Navigate to
the DEba rment Status @ Main 2022-8267-SW-IPD-1-PR0O34276026 > ® O

B Notwes Project > Activity
ta b ° Download Form Summary Relevant File(s): B

After inputting the information below please click SAVE DRAFT. Step 37
SHEET|  DEBARMENT STATUS I_LTTEST:.T N

o Please verify that YOUR VENDOR or CONTRACTOR is not on the federal debarment list

Any entity receiving TDEC grant funds must provide non-debarment verification if total geods or services for the open contract are equal to or greater than $25,000. Search for your vendor or contractor to confirm that it's not on the Debarment List by going to Systermn for Award Management (SAM]). *

GENERAL INFORMATION BIDS/QUOTES SUMMAI

Step 38: If your entity
meets the $25,000
threshold, upload (IES)
“Debarment Status
Verification”
documentation.

*Please note, 1o search for a vendor on the SAM.gov site, you need to log in.
Click *SEARCH" tab

In the search bars type in the Entity name or using an exclusion search term, Unique Entity Identifier (UEI) and/or the Entity Commercial and Government Entity {(CAGE) code. You can only use one search bar at a time 1o search for records. Individuals are not assigned a UEl number or CAGE code. When checking for a
debarred individual, conduct the search by typing the name in the top bar.

Click the magnifying glass button to retrieve a list of results. Entities with "Exclusion” listed in purple are currently debarred, while those labeled "Entity” in green do not have exclusions. In the right upper corner of the webpage, use the Download option and upload a summary of search results.

Upload Debarment Status Verification, If Applicable

If your entity meets the 525,000 threshold, please uplead verification that you are not on the Debarment List.

[J FileName = Size  Date
@ Debarment_Status.docx 116KB 07/09/20238:21PM }
Total Files: 1
° . .
I I ° l ,D/O aded Items WI// Gomments from Reviewer for Debarment Status Tab (view only)
°
€BACK NEXT»

appear under "File
Name”

Note: /f applicable, read through the “Comments from Reviewer for Debarment Status Tab”
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Procurement Threshold (>$50,000 or Required): Attestation Tab

Step 39: Navigate to the
Attestation tab.

Step 40: Review and
check off the each of the
Attestations. This
signifies the grantee’s
acknowledgement and
understanding. Use the
comment box below the
corresponding attestation
to explain applicable
exceptions.

Note: In this section,
fields marked with an
asterisk (*) are required in
order to submit for
review.

GEMERAL INFORMATION FORMAL PROCUREMENT BIDS/QUOTES SUMMARY WORKSHEET DEBARMENT STATUS | ATTESTATION I >

Attestation itemns with & * are required to be completed before signing and submitting the procurement package for review. If these items are not completed, you will receive an alert that the submission is incomplete.

~ Procurement Threshold Attestation (> $50,000) | I Step 40

eral contract provisions are detal

contract provisions are included in the terms and conditions of the agreement to the best of my knowledge. All require

| ed in the Required and Recommended SLFRF Contract
sted provisions are alzo detailed in 2 CFR 200 327

[ 1 attest (if contract awarded and agreement in place) that the reguire
Provisions appendix B item included in the Implementation Guidelines. Th

oo

ra
I

Comments (If exceptions please explain in the box below.)

[] * | attest that invitation for bids were publicly advertised or solicited from an adequate number of gualified sources, providing at least 14 days response time prior to the date set for opening the bids

Comments (If exceptions please explain in the box below.)

%~

[ * | attest, for solicitations posted after January 31, 2023, that the Go-DBE posting steps have been completed and the solicitation was listed for a minimum of 14 days_ For procurements completed prior to January 31, 2023, please provide brief description of how, to the greatest extent poss

compliance with the federal requirement of 2 CFR 200.321 were met and how small and minority businesses, women's business enterprises, and laber surplus area firms were considered:

Comments (If exceptions please explain in the box below.)

Y-
[ 1 attest, to the greatest extent practicable, a preference was given to contractors and vendors for the purchase, acquisition, or use of goods, products, or materials preduced in the United States (including but not limited to iren, aluminum, steel, cement, and other manufactured products).
Comments (If exceptions please explain in the box below.)

Y-
[] For projects that will utilize greater than $10M of ARP SLFRF funding or for projects that will combine funding with a federal funding source that reguires Davis-Bacon, | attest that | am aware of the requirements and will comply with Davis-Bacon.
Comments (If exceptions please explain in the box below.)

Y-

o
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Procurement Threshold (>$50,000 or Required): Attestation Tab Cont.

Step 41: Sign and Date
accordingly.

[ If this procurement is associated with a contract that has already been awarded, | attest that a notification of award was issued {with rationale if not awarded to lowest bidder fer Construction projects). Please add a note stating the date of award.

Comments (If exceptions please explain in the box below.)

Step 42: Click Save Draft P
a n d th e n Cl i c k s u b m it. [ | attest that the appropriate permits per State requirements were obtained (or will be obtained) prior to construction.

Comments (If exceptions please explain in the box below.)

~
N Fields without
.
Ot e (] I e S W I O u a n | attest that the bonding requirements determined 1o ensure the Federal interest is adequately protected have been met or at a minimum:
. * .
asterisk (*) are o ptiona | and () Forconsrction pejcts o, i g o eac e vl 1 v pecent of th i i hs b ecived
t . d . d t Comments (If exceptions please explain in the box below.)
bmit f. ' ’
* (] * I attest that to the best of my knowledge a complete procurement package has been uploaded
Comments (If exceptions please explain in the box below.)
4

* Subrecipient Signature Step 41

* Date

mm/dd/yyyy =]

€ BACK
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Procurement Threshold (>$50,000 or Required): Authority to Award

S ETS

Step 43: Once TDEC has
reviewed and approved the
pre-award documentation,
the Procurement Status
changes to “Authority to
Award”.

The Grantee will receive a
confirmation of status and
receive an Authority to
Award letter via email.

Step 44: Navigate to the
Manage Projects and the
Procurements section.
|dentify the in-progress
procurement by the
Procurement UID. Click
Open.

2022-8899 () > @
MANAGE PROCUREMENTS PURPOSE AND OVERVIEW TIMELINE, ELIGIBILITY & FUNDING SELECTION CRITERIA RESOURCES AND CONTACT TITLE VI COMPLIANCE GENERAL INFORMATION BUDGET AND ATTACHMENTS GENERAL PROPOSAL INFO PARTNER INFORMATION
Procurements

ProjectID % Item or Service Procured % MName of C: Or ization R ded for Awarded % Procurement uiD %+ Activity Type  + Status %  Budget Amount % Committed Amount = Paid Amount = Remaining Amount %

$50,001.00 $50,001.00

|m DW-P-1 item Company 2022-8899-DWHP-1-PRO34189167 I Procurement y
m DWHP-1 Step 44 2022-8899-DWHP-1-PRO34189203 Procurement Pre-Award 50.00 $0.00
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Procurement Threshold (>5$50,000 or Required): Awarded Contract

Stage

Step 45: If the
procurement has
completed the Pre-Bid
stage, the Pre-Award
stage, and is currently in
the Awarded Contract
stage, select all three
boxes.

Note: In the Awarded
Contract stage, only the
Formal Procurement

tab contains editable
fields.

GEMERAL INFORMATION I FORMAL PROCUREME I BIDS/QUOTES SUMMARY WORKSHEET DEBARMENT STATUS ATTESTATION

Helpful Guidelines and Resources

o Stages of Procurement
Pre-Bid is the stage prior to posting the solicitation. It is a review stage where TDEC will cenfirm all pre-bid decuments to include the Bid or Proposal package, supplemental information, advertisement and procurement policy.

* Apre-bid review is strongly recommended for projects that have not been procured. The pre-bid review will examine local purchasing,/procurement policies, review the Request for Quote (or Bid or Proposal), and review the requirements of the procurement and the supplemental conditions. The pre-bid review will
assist with making the approval of procurements more efficient and streamlined

Pre-Award is the stage pricr to officially awarding a contract to a vendor, but after evaluations have been made of responses received. This is a required review stage and for projects not yet started, this stage will result in an Authority to Award (ATA).
Awarded Contract is the stage after a contract has been let and it is the final procurement approval that is reguired for reimbursements to be allowed.

* Select the stage of the procurement you are currently in and the stage(s) you have already completed | Step 45 |

Guidance: Once you have selected the stage(s), please fill out the corresponding sections you have selected below.
Fre-Bid
Pre-Award

Ewarded Contract
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Procurement Threshold (>5$50,000 or Required): Awarded Contract

Stage Cont.

Step 46: Upload (ER) the
following items within the
Awarded Contact section:

« Award Notification and
Rationale to Award*

« Contract with pricing
information (required, once
contract in place)

« Required Bidder/Contractor
Certifications (required, once
contract in place)

« Documentation to support
execution of performance and
payment bonds (required, once
contract in place)

« Any additional documentation

Step 47: Select Yes/No to
indicate if the procurement
applies to multiple projects
under the grant.

ATTESTATION ) @

GEMERAL INFORMATION | FORMAL PROCUREMENT I BIDS/QUOTES SUMMARY WORKSHEET DEBARMEMT STATUS

|| Step 46 |

~ Awarded Contract

* award Novification and Rationale to Award (if not awarded to the lowest bidder)

If available, the notification 1o award memor. ement package. If the bidder awarded the contract is not the lowest bidder, a justification stating the rationale for the award should be included.

andum should be included in the procurs

Contract with pricing information (required, if contract in place)

If awarded a contract, the agreement with the selected vendor should be provided. This documentation represents the contract between the vendor and the Grantes and should include all required federal contract provisions.

Required Bidder/Contractor Certifications (required, if contract in place)

Some specific certifications are requi oted by the State or federal govemment. The certificates include (copies provided in Appendix B): Iran Divestment, Debarment, Equal Employment Opportunity, and the BYRD Amti-Lobbying Amendment Certification.

red during bidding or from vendors n

Documentation to support the execution of performance and payment bonds (required, if contract in place)
For i ility improw ement contracts or subcontracts d ing the Simplified Ac q sition Threshold, t h antee shol Idy::r' de documentation that supports the protection of the Federal interest This requirement orted through a bid guarantee that includes a firm commitment such as a bid bond,
oenf d heck other negotiable instrument a: p ngabd ssurance that the bidder will, upon acceptan: th bid, execute such contractual documents as may be re".Jlred vithin the time specified. Bonds h Idt 1 ‘IIIII of the total contract price.

Upload any additional documentation you would like TDEC to know about

* Does thie procurement apply to multiple projects under this grant?

O ves (O No

Comments from Reviewer for Formal Procurement Tab (view only)

< BACK NEX

e

i i Note: If applicable, read through the “Comments from Reviewer for Formal Procurement Tab”
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Procurement Threshold (>$50,000 or Required): Attestation Tab

Step 48: Navigate to the
Attestation tab. [ Stepss |

GEMERAL INFORMATION FORMAL PROCUREMENT BIDS/QUOTES SUMMARY WORKSHEET DEBARMENT STATUS | ATTESTATION
.
.
Ste 49 . ReVI eW a n d C h e C k Off t h e [ If this procurement is associated with a contract that has already been awarded, | attest that a notification of award was issued (with rationale if not awarded to lowest bidder for Construction projects). Please add a note stating the date of award.

each of the Attestations to Comments (f excepions please explain i the box below.)

acknowledge understanding. Use P
the comment box below the T T e e e e e

correspon din g attestation to Comments (1 exceptions please explain n th bo below)

explain applicable exceptions. p

| attest that the bonding requirements determined 1o ensure the Federal interest is adequately protected have been met or at a minimum:

L3
Ste p 50 4 S Ign a n d D a te [J For construction projects only, a bid guarantee from each bidder equivalent 1o five percent of the bid price has been received
.
a CCO rd i ngly Comments (If exceptions please explain in the box below.)
.

[] * I attest thatto the best of my knowledge a complete procurement package has been uploaded

Step 51: Click Save Draft and
then click Submit. )

The input of procurement
details is now complete!

Note: The TDEC team will review o ] e

the submission and respond

within 14 days. Once approval is

received, the grantee may submit

reimbursements for the 35
approved procurement.




Process for Requesting Procurement Support

= To contact the TDEC team
with a procurement issue,
click the Notes tile located
on the toolbar to the left.

= (Click the (+) button and a
pop-up window will open.

= Select“Note to TDEC”
from the Type drop-down
menu. Enter any question
or comment for the TDEC
team in this text field.

= Upon saving the message,
the system will notify the
TDEC team. The TDEC
team will then review and
respond to the inquiry.

GMS will alert the inquirer
of a response via email.

Activity

Project » Activity

Type: —all—

No Records Found

v | From: mmy/dd/yyyy

To: | mm/dd/yyyy

o

Activity

3 Notes

Type:

Note to TDEC ~

Save Cancel
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GMS Engineering and Admin
Services Approval Process

TN Depa.rtment of
Environment &
= CONservation



GMS Engineering and Administrative Services Approval Process

To create a procurement
associated with
engineering and
administrative costs:

Step 1: Navigate to the
Manage Projects tab
and the Projects
section.

Step 2: Identify the

project with the Project
ID “Grant Admin".

Step 3: Click Create
Procurement. (The
Procurement Activity
landing page will then
open on the screen.)

Step 4: Continue the
procurement process,
beginning with the
General Information
tab (see Slide 8 for
additional instructions.)

2022-8084 (Warren County)

How to Create New Activity

Application Status: Approved Application Type: DWR-ARP Mon Collaborative Grants State Water Infrastructure Grants (SWIG) program

Application ID:  2022-5084 (Warren County) Application completed by: Michael Green 4

You have $5,596,564.91 remaining out of $5,596,564.91

MANAGE PROCUREMENTS PURPOSE AND OVERVIEW TIMELINE, ELIGIBILITY & FUNDING SELECTION CRITERIA RESOURCES AND CONTACT TITLE VI COMPLIANCE GEMERAL INFORMATION BUDGET AND ATTACHMENTS

Projects

Procurements can be entered as needed for each project by clicking the Create Procurement button next to the corresponding project.

# Project ID

m 1 DW-COStd-01 808401 Submitted
m 2 DW-PDC-02 808402 Submitted $0.00
m 3 DW-PDC-03 808403 Submitted 50.00
m 4 WW-COStd-01 808407 Submitted $0.00
m 5 WW-PDC-02 808406 Submitted $0.00

6 WW-PDC-03 808404 Submitted $0.00

C-M 808405 Submitted 50.00

% US Treasury Project ID %+ Project Name % Status Total Amount %

$2,698,252.46

Warren County Admin Draft 50.00

$2,698,282.46

GEMERAL FRO

POSAL INFO

Total Committed s

50.00

$0.00

$0.00

$0.00

$0.00

$0.00

$0.00

50,00

$0.00
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GMS Process for Requesting

Reimbursement

TN Depa.rtment of
Environment &
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GMS Process for Requesting Reimbursement

Step 1: Once logged in;
Navigate to the My
Applications tab and
click the Active tab.
Then, identify the grant
associated with the
reimbursement activity.

Step 2: Select the
application and click
“View” to begin the
reimbursement activity.

Current session: You are logged in as Sunshine, City of, to switch your organization click the Switch Organization button on the top right.

For Grants System Help, contact TDEC.Grants@tn.gov. For application questions, please contact the Grant Program Contact listed in the application.Note: 1t is recommended to use the Firefox browser while sccezsing the system for optimal performance.

| Procurement Guidelines

* Submit Affiliation Request How to Affiliate Tutorial ( Change Password

X Funding Opportunities +8
Opportunity Details % 1-39 of 39
Material Management - Convenience Center Grant s 2
tep o DWR-ARP Non Collaborative Grants State Water Infrastructure Grants (SWIG) program Sunshine, City of Approved 06/27/2023 03:53PM
Deadline: 07/01/2023
Deadline Passed 0 & 2022-8386 I DWR-ARP Non Collaborative Grants State Water Infrastructure Grants (SWIG) program Sunshine, City of Approved 06/27/2023 03:53PM
O 9 20194854 RES Planning Grant Sunshine, City of Approved 06/13/2023 09:12AM v

..* PENDING (0) O COMPLETED (0)

Material Management - Used Oil Grant

CUREMENTS (PENDING) (8

Deadline: 07/01/2023

Deadline Passed

# Application ID % Activity Type % Organization 4 Status £ LastModified ]

Mo matching records found

DWR-ARP Regionalization Grants State Water Infrastructure Grants (SWIG)

Deadline” 08/08/2023
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GMS Process for Requesting Reimbursement

Step 3: Click on the
Activities tab on the
left-hand side of the
toolbar. The Activities
landing page will then
open on the screen.

TN o

Envi t&
Conservation

@ Main 2022-8899 ()
[® Notes
[E] Activities 5

Application Status: Approved

Application ID: 2022-8899 ()

MANAGE PROCUREMENTS

Projects

PURPOSE AND OVERVIEW

Application Type: DWR-ARP Collaborative Grants State Water Infrastructure Grants (SWIG) program
You have $25.00 remaining out of $25.00
SELECTION CRITERIA

TIMELINE, ELIGIBILITY & FUNDING RESOURCES AND CONTACT

Procurements can be entered as needed for each project by clicking the Create Procurement button next to the corresponding project.

m Create Procurement
m Create Procurement

Procurements

ProjectID = Item or Service

m DW-IP-1 Concrete
m WW-IPD-1 Water Tower
m DW-IP-1 Water Tower

TITLE VI COMPLIANCE

#  ProjectID % Project Name + Status s Total Amount =
1 DW-IP-1 Project 1 Submitted $100,000.00
2 WW-PD-1 Waste Water Project 1 Submitted $500,000.00
$600,000.00
d + Name of C g ded for ded + P uID < Activity Type Status
2022-8899-DW-IP-1-
Concrete Co. PRO33566016 Procurement Approved
2022-8899-WW-PD-1-
Water Inc. PRO33566008 Procurement Approved
3lie 2022-8899-DW-IP-1- i
Drinking Water Company PRO33612276 Procurement Submitted

GENERAL INFORMATION

Total Committed =

$0.00

$0.00

$0.00

% Budget Amount + Committed Amount + Paid Amount + Remaining Amount +

$100,000.00

$500,000.00

$12,000.00

BUDGET AND ATTACHMENTS

]
> ®

GENERAL PROPOSAL INFI >

12012

Total Paid = Total Remaining  +
$0.00 $100,000.00
$0.00 $500,000.00
$0.00 $600,000.00

$0.00 $0.00 $100,000.00
$0.00 $0.00 $500,000.00
$1200n NN

NEXT >
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GMS Process for Requesting Reimbursement

Step 4: After the
activities page loads, | zm
navigate to the @ v 2022-8899 () > ©

Req u est fo r G ra n t B Notes < 2 COLLABORATIVE APPLICATION REVIEW TITLE VI TRAINING CERTIFICATION REQUEST BUDGET REVISIONS BUDGET ACCEPTANCE SUB-CONTRACTS I REQUEST FOR GRANT REIMBURSEMENT |FFATA DATA COLLECTION FORM

° Activities s i= Reimbursement List View v 1-30f3
Reimbursement . 83 |

t b Application , Reimbursement . N R . — . Form . . Invoice . Reimbursement . Payment . Grant . Last . . .
a . D T ID = AETEITE - O © A e ¥ completedby ~ SERMG Number ¥ Request #: ¥ Amount ™ Balance 7 Modified - Dy -
. DWR-ARP Collaborative Grants Test
2022-88%9 10059 Reguest B (B Sunabinettily State Water Infrastructure JlesliOioanezation Draft igle/a02s Organization
Reimbursement of Contact 1 04:42PM
Grants (SWIG) program Contact 1
L] n
Ste p 5 . C re a te a eW y Request For Grant Sunshine, City DWR-ARP Collaborative Grants Test Organization 04/18/2023 Jlest B
2022-8899 10060 . State Water Infrastructure Draft Organization
Reimbursement of Contact 1 05:07PM
Req uest for Grant e S e o
DWR-ARP Collaborative Grants Test

2022-88%9 10057 HequestionGran Sunabinettily State Water Infrastructure Kyle Bangug Submitted 10001 $100.00 L2 202 Organization

Reimbursement by bt of G (416 o
clicking the (+)
button.

Note:
Reimbursement can
only be requested
for projects with
approved
procurements. 42




GMS Reimbursement Process: General Tab

Department af
TN Environment it &

Step 6: Navigate to the —
General tab.

2022-8899 ()

Grant > Activity

Ste p 7: Cl i C k th e E nte r GENERAL SUPPORTING DOCUMENTATION CERTIFICATION ACTIVITY SUMMARY ACTIVITY COMMENTS
Exp.e n d It u r.es b u tto n to [E Activity Type: Request For Grant Reimbursement
begin the reimbursement N

activity.

Organization: Sunshine, City of

v Expenditures and Individual Accountability Report

A new pop-up window will
open.

Reimbursement ID

10066

* Expenditure Report

Note: In this section, fields
marked with a red asterisk (*)
are required in order to
submit for review.

v Reimbursement Form

Click "Save Draft" to update after entering values in the Expenditures Report

Reimbursement Request Summary

nnnnnn 5
Currant Funds. Total Grant Praviousty Total Grantes
fotal it Submitte at e o TotmlGramtes Y CumentGrantee T Grantas M latch
nnnn Cartract Eudy = Raquestes Comtract  ContractBalnce o PR wwentsd O e Magen  CEUEENEE
ExpendRures  mount Du! Expendiwrss 7 Grantes Match Expandtturs

1.2 Zalaries,

43

£20,000,000.00 1,001.00 so.00 S1,001.00  §19,998399.00  $20,000,00.00 54,200.00 2000




GMS Reimbursement Process: Match Individual Accountability / Equipment

Step 8 | Match Individual Accountability/Equipment Report (IAR)

Step 8: Navigate to the Match
I n d iVi d u a I o For more information on Co-funding requirements, please see the Implementation Guide.

Match documentation should be uploaded to reimbursements at least quarterly. Match documention related to In-Kind Labor,

Accou nta bi I ity/ Eq u i p m e nt Volunteer, Equipment or Land, or for costs that are not related to specific grant-funded procurements available in the below
dropdowns, enter in the appropriate sections below.
Report (IAR).

Upload match documentation in the supporting documentation tab, including *_MATCH" in the file names

***Disclaimer: Please report cumulative totals, per volunteer/employee/equipment. For example- each line item can support x
employee for working y hours, or x material at y amount/value. As a grantee, you are required to keep detailed information to support

Step 9: E nte r th e m atC h (CO' those cumulative totals. Volunteer/Organization name can be reported as a cumulative totals.
fu n d I ng) I nfo rm at-l O n ) -I—O b egl n | Step 9 | InKind (Volunteer/Equipment/Land Match)
entering the details, click the (+)

In-Kind Item/Volunteer oq Hours/Quantity/If Land-enter Rate of Pay or Value of
d th t f t h t h ° pate Namej/Land Match AN 2 T BT 1 6] o e e Gross Pay or Value
unaer the category o e matcn.
Total: $0.00

* In-Kind (Volunteer/Equipment/Land [+]
M atCh) Grantee Staff Workforce

° G ra n te e Sta ff WO r kfo rc e Date Employee Name Work Description Hours Rate of Pay or Value ($) Gross Pay or Value

« Match Documentation - & | |
Professional Fees, Grant Award

CO Sts Match Documentation - Professional Fees, Grant Award Costs

Match Source Vendor/Description Invoice #(s) nvoice Date(s) Total Invoice Amount Amount to Match ($)

« Match Documentation - Capital 0q
Purchase Costs B

Th e text f| e | d S fo re nte r| N g m atc h Match Documentation - Capital Purchase Costs
d eta i | S Wi | | p O p u | a te O n th e Match Source Vendor/Description Invoice #(s) Invoice Dz:::: Total Inveice Amount Amount to Matcl;:s:c
screen. — a4

Save Clear




GMS Reimbursement Process: Expenditure Report

Step 9: Navigate to the Expenditure [seeo |

Expenditure Report |

Report.

Step 10: To begin enteringh
expenditure details, click the (+)
under the Procurement field and
options of approved procurements
for the grant will appear.

Step 11: For each procurement,
complete the requested fields:

 Procurement

* |nvoice #

* |nvoice Date

« Total Invoice Amount

« Amount Requested for
Reimbursement

« Amount of Match (co-funding)

The text fields for entering match
details will populate on the screen.

0 Enter expenditures in the sections below. Reimbursements must be broken down by project and procurement/supplier. Grantees will
need to enter multiple line items if the request includes multiple projects or suppliers. To begin entering expenditures, select the
dropdown for the Procurement field and options of approved Procurements for the grant will show. The approved procurements are in
the form (Project ID — Supplier — Procured tem or Service). Select the approved procurement ID/project to request reimbursement for
and complete the details.

Salaries, Benefits Taxes (1,2)

Amount Requested For

Reiminrs © Amount of Match ($)

Procurement Invoice # Invoice Date Total Invoice Amount

Test Project ID 2, Test W mim,/dd/yyyy = $0.00

-Step 11

Calculated Total In-Kind Value

from |AR from Grantee Staff $0.00
Workforce:
Total: $0.00 $0.00

Professional Fees, Grant Award (3,4)

Amount Requested For

Procurement Invoice # Invoice Date Total Invoice Amount e t(S) Amount of Match (5)
+

Calculated Total - Match -

Professional Fee, Grant and $0.00
Award:

Total: £0.00 £0.00

Note: Co-funding minimums must be satisfied prior to closeout and are reviewed on a

grant basis, rather than a project basis. While there is no requirement that co-funding
contributions be submitted on each reimbursement request, it's best practice to submit 45
at least quarterly, and co-funding will be reviewed on an incremental basis.



GMS Reimbursement Process: Expenditure Report Cont.

Step 12: Continue completing the
requested field for each applicable
Expenditure field:

Salaries, Benefits, Taxes (1,2)

Professional Fees, Grant Award
(3,4)

Other Non-Personnel (18)
Capital Purchase (20)

The text fields for entering match
details will populate on the screen,

including the Grant Total fields.

Step 13: Click Save.

| Step 12 |

Sal Benefits T (1.2)
Procurement Invoice Invoice Date Total Invoice Amount AmountRequested For o0 00 of Match )
imbursement (]
Test P D2 Test ¥ d -
+
Calculated Total In-Kind Value
from IAR from G Staff 50.00
arkforce:
$0.0 $0.
Professiona | Fees, Grant Award (3.4)
Procurement Invoice & Invoice Date Total Invoice Amount  Amount Requ e e Amountof Match (3
r
aaaaaaaaaaaaaaaaaa
Professi ee, 50.01
Award
tal $0.0 S0.
Other Non-Personne 1 (18)

....................
mmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmm ® Amount of Match (S)
+

ulated Tot
(Volunteer/Equipment/Land $0.0
h):
al: $0.0 $0.1
Capital Purchase (20)
Procurement Invoice # Invoice Date Total Invoice Amount  AmountRequ :': t::(F;' Al of Match ()
+
aaaaaaaaaaaaaaaaa
entation - Capital $0.01
ase:
$0.0 $0.
Grand Total
Total Invoice Amount AmountRequested For o0 0y of Match 8
imbursement (]
$0.00 $0.00 50.00

o s |
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GMS Reimbursement Process: Expenditure Report Cont.

Step 14: Once the
expenditures are entered o
and the summary tables 10090
populate, enter Yes or No ¢ Expenditure Repor
for the following questions:

v Expenditures and Individual Accountability Report

. . =]
® D OeS th | S req u est | n Cl u d e o Project Owners, Grantees or Partners may be required to hold retainage in amount equal to 5% of each invoice for contracts containing construction activities. Please refer
] to your local policies & Authority to Award to identify if retainage is required. If so, please upload evidence of retainage to the Supporting Documentation tab under “Proof of
rel m b u rse m e nt fo r' a Payment to Vendor For Each Line Item".
contract containi ng
. e [FOGES This request INclude relmbUTSement 10T @ CoNtract containing construction acuvites? Step 14
construction activities? e One L step 14 |
« Does this request include i
1 Projects requesting an initial reimbursement greater than 25% of the total project budget AND include construction already underway, may be required to have a site
rel m b u rse m e nt fo r o inspection prior to reimbursement approval.
project(s) containing
CO n St ru Ctl O n a Ct IVItI e S th at * Does this request include reimbursement for project(s) containing construction activities that have already started? —
O Yes (O No (O N/A (no construction activities included in this request) Iep—l
have already started?
. * Does this request exceed 25% of the total project budget?
[
D Oes th I S req u eSt EXCEEd (O Yes (O No (O N/A (no construction activities included in this request)
25% of the total project —

budget?

. 47
Step 15: Click Save Draft.



GMS Reimbursement Process: Summary Tables

Step 16: In the
reimbursement activity,
click Save Draft. After
saving the draft, the
Reimbursement Request
Summary Table will update.
This table details the grant
budget balance after the
reimbursement submittal.

The Reimbursement
Request Project Summary
Table will also update. This
table details the individual
project’s budget balance
after the reimbursement
submittal.

Reimbursement Request Summary Table

Previously .
Total Grant Submitted Grant e e Total Grantee Prewolusly Current Grantee Wl Grantee Match
Category Contract Budget FECrr Requested Contract Contract Balance Contract Mateh Submitted Match Match e
9 . (Amount Due) Expenditures Grantee Match Expenditures
Expenditures
1,2: Salaries, $5,000,000.00 $0.00 $500.00 $500.00  $4,999,500.00 $500.00 $0.00 $500.00 $500.00 $0.00
Benefits & Taxes e : : . ,99,0U0. . ! 500. 500. J
4,15:
Professional Fee, $500.00 $0.00 5500.00 $500.00 50.00 $500.00 $0.00 $500.00 5$500.00 $0.00
Grant & Award
: Previously Submitted Total Supplier o -
Project ID Supplier Co:v:t)rt:::ts ;55“: Supplier Contract Cur:?eentuFeusrt\:: Contract Reg:)z:;\::g S;;T:::;
9 Expenditures q Expenditures

DW-IP-1 company $500,000.00 $510.00 $40,000.00 $40,510.00 $459,490.00

Total DW-IP-1 Total $500,000.00 $510.00 $40,000.00 $40,510.00 $459,490.00

SW-CoStd-1 Construction Inc $500,000.00 $60.00 $40,000.00 $40,060.00 $459,940.00

]I:g::: i $500,000.00 $60.00 $40,000.00 $40,060.00 $459,940.00

WW-IPD-1 Water Inc $500,000.00 $624.00 $5.00 $629.00 $499,371.00

Total WW-IPD-1 Total $500,000.00 $624.00 $5.00 $629.00 $499,371.00

Total Grand Total $1,500,000.00 $1,194.00 $80,005.00 $81,199.00 $1,418,801.00
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GMS Reimbursement Process: Reimbursement Form

Step 17: Navigate to
the Reimbursement
Form section. Here
you will see the
Summary Tables as
described in the
previous slide.

Step 18: Enter the
Remit Address and
the Service Date
Period.

 Reimbursement Form | | Step 17

Click *Save Draft’ to update after entering values in the Expenditures Report

Reimbursement Request Summary

i mamomam  swETLM ®nm  mmme

Reimbursement Request Project Summary
== el it P =]
et

Remit Address

IMPORTANT: If the Remit Address has changed since the last reimbursement request or grant, you must complete this form. If you would like to submit or update information for direct deposit, you must complete this form. For either request, you must mail the ORIGINAL form to the address below. Mark the outside of the envelope "CONFIDENTIAL"

State of Tennessee

Attn: Supplier Maintenance

21st Floor WRS Tennessee Tower
312 Rosa L Parks Ave

Nashville, TN 37243

Expect a minimum of 10-15 business days for processing. Please enter below the date the address was mailed to let the grant program know when a new Remit Address has been submitted to Supplier Maintenance.

Tip: Be sure to
frequently click “Save
Draft” to ensure
progress is not lost.

* Street Address 1: | Step 18 |

Street Address 2:
* City:
* State:
* Zip Code:
* Service Date Period

Dates of service covered in this request (Example: x/xo/ XX T0 X3/ XX /X0XX)

NEXT >

< sons
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GMS Reimbursement Process: Supporting Documentation Tab

Step 19: Navigate to 2022-8899 ()
the supporting Submission Manager > Gramt »> Activity

D o c u m e n tat i o n Ta b GEMERAL I SUPPORTING DOCUMENTATION | CERTIFICATION ACTIVITY SUMMARY ACTIVITY COMMENTS NTERMAL
.
* Invoices for expenses

Step 20: Click the upload Recuired or dll xpenses.
button (ER) to upload the =

req U i red rel m b U rse m e nt Documentation for Grantee Staff Workforce

d 0 C u m e n tatl 0 n : Only necessary if In-Kind Hem Identified in Approved Contract.

» Invoices for expenses B

- Documentation for grantee _
staff workforce if in-kind v Proof of Payment to Vendor For Each Line Item
item ident’:fiEd in apprOVEd Upload one of the following for each contracted payment: Check Register, Copy of Check Issued, Cancelled Check or Credit Card Statement
contract

Upload Proof of Payment:

+ Proof of Payment to B
Vendor for each line item

« Retainage documentation

:f l A bl t ATA File Name should be in the format of: Project ID-Escrow Statement-Vendor-Statement Date. File Description should contain the reimbursement request amount follewed by the 5% retainage amount (Example: Request $200,000, Retainage $10,000)
(if applicable, refer to ATA)

[ & ]
+ Proof of Payment for In-
Kind labor ~ Proof of Payment for In-Kind Labor

Ste p 2 1 . C | i C k Save D ra ft (If applicable) Upload copies of the following: Signed Timesheets, Signed List of Employees, Hours Worked
L] L]

Upload Proof of In-Kind:

Note: Invoices are B
required for all expenses. T s

Upload a copy of the Escrow account statement showing the account balance meeting the 5% retainage requirement has been met.

€ BACK

[[seveonr || v swmi ] osee |




GMS Reimbursement Process: Certification Tab

Step 22: Navigate to the
Certification tab.

TN Department of
Environment &
Conservation

Step 23: Review and
check off the -

. 2022-8899
Attestation to G > Actiy 0 o
a C kn OWl e d ge GENERAL SUPPORTING DOCUMENTATION CERTIFICATION ACTIVITY SUMMARY ACTIVITY COMMENTS
understanding. —
\ certify to the best of my knowledge and belief that the data above is correct, all expenditures were made in accordance with the contract condition, and payment is due and has not been previously requested
* Name
Step 24: Sign a n d Subrecipient Name
Date accordingly. -

Subrecipient Title

The input of Date signed

reimbursement details  |[osozz02
is now complete! ¢BACK NEXT >
[ svenrat || v submit |

Step 25: Click the

Submit button and the

reimbursement request

will be submitted to the

TDEC team for review. ol



GMS Reimbursement Process: Activity Summary Tab

Tip: To download a
summary of the m T ¢
reimbursement

i =12
form, navigate to the
. . 2022-8899 () > ®
Activity Summary |c..; sy
tab and Clle the GENERAL SUPPORTING DOCUMENTATION CERTIFICATION ACTIVITY SUMMARY ACTIVITY COMMENTS
Form Summary
Download Form Summary
buteon =
< BACK NEXT »
A pop-up window

with a .pdf summary
of the form will
appear. Save the
document to your
computer.
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Process for Requesting Reimbursement Support: Activity Comments

= To connect with the TDEC team on a
reimbursementissue, navigate to the
Activity Comments tab.

= (lick the (+) button and additional text
fields will populate. Populate the fields
and input the question or comment.

=  Once finished, click the “Send
Comment/Question to TDEC" button
and the team will be notified. When a
response to the inquiry has been
entered into this tab, a notification
email will be sent to all POCs listed for
the grant.

= Communications from the Reviewer(s)
relating to status and/or Requests for
Information (RFIs) will be sent here.

Note: This feature is only available in the
Draft and Revisions Requested Status.

GEMERAL SUPPORTING DOCUMENTATION CERTIFICATIOMN ACTIVITY SUMMARY

ACTIVITY COMMENTS

Activity Comments:

f TDEC staff have entered comments regarding this activity, they will appear below.

Questions/Comment/Response

1. Click the "+* button below to emter your comments and guestions to TDEC Staff
2_0nce you have entered your information, click the “Save Draft” or "Save”™ button.
NOTE: If you do not click the "Save Draft” or "Save” button, your comment will not be saved.

3.Click the "Send Comment/Question to TDEC".
TDEC Staff will review and respond through the same process. You will receive an email notification when a response has been entered

NOTE: YOU MUST CLICK SAVE BEFORE SENDING YOUR COMMENTS TO TDEC STAFF OR YOUR COMMENT WILL NOT BE SAVED.

Date Grantee/TDEC Staff Select Type Mame Comment/Question/Response

. B3

How do you request for

YT
4/26/23 reimbursement?]

Relevant File(s)

Send Comment/Question to TDEC

Grantee L Question  w Test

23




GMS Title VI Training
Certification Process

TN Depa.rtment of
Environment &
= CONservation



GMS Title VI Training Certification Process

Note: The Title VI
Training Certification
only needs to be
completed once per
grant contract term.

Current session: You are logged in as Sunshine, City of, to switch your organization click the Switch Organization button on the top right.

For Grants System Help, contact TDEC.Grants@tn.gov. For application questions, please contact the Grant Program Contact listed in the application.Note: 1t is recommended to use the Firefox browser while sccezsing the system for optimal performance.

* Submit Affiliation Request How to Affiliate Tutorial ! Procurement Guidelines ( Change Password

Step 1: Navigate to the

My Applications tab oot 2o —
a n d Cl i Ck th e Active R 1-130f13 (& IN PROGRESS (32] <4 ACTIVE (39) || 7= COMPLETED (5) .

. .
ta b I h e n I d e n t I f th e Material Management - Convenience Center Grant
0 Vi O 7 2022-8267 DWR-ARP Non Collaborative Grants State Water Infrastructure Grants (SWIG) program Sunshine, City of Approved 06/27/2023 03:53PM

Deadline: 07/01/2023

.
A R P CO | | a b O ra t I Ve O r Deadline Passed I Step 2 | I O & 20228366 DWR-ARP Nan Collsborative Grants State Water Infrastructure Grants (SWIG) program Sunshine, Cityof  Approved 06/27/2023 03:53PM |
Non- Collaborative e e FesFeng e e o -

Grant State Water

Material Management - Used Oil Grant
T PENDING (0) O COMPLETED (0) i PROCUREMENTS (PENDING) (86) {"* PROCUREMENTS (SUBMITTED) (75) it PROJECTS (68)

Infrastructure Grant. e 1 —

# Application ID % Activity Type % Organization 4 Status £ LastModified

Mo matching records found

Step 2: Select the o

application and click e
“View" to begin the

Title VI Training

Certification activity.
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GMS Title VI Training Certification Process

Step 3: Click on the
Activities tab on the
left-hand side of the
toolbar. (The Activities
landing page will then
open on the screen.)

TN o

Envi t&
Conservation

@ Main 2022-8899 ()
[® Notes
[E] Activities 5

Application Status: Approved

Application ID: 2022-8899 ()

MANAGE PROCUREMENTS

Projects

PURPOSE AND OVERVIEW

Application Type: DWR-ARP Collaborative Grants State Water Infrastructure Grants (SWIG) program
You have $25.00 remaining out of $25.00
SELECTION CRITERIA

TIMELINE, ELIGIBILITY & FUNDING RESOURCES AND CONTACT

Procurements can be entered as needed for each project by clicking the Create Procurement button next to the corresponding project.

m Create Procurement
m Create Procurement

Procurements

ProjectID = Item or Service

m DW-IP-1 Concrete
m WW-IPD-1 Water Tower
m DW-IP-1 Water Tower

TITLE VI COMPLIANCE

#  ProjectID % Project Name + Status s Total Amount =
1 DW-IP-1 Project 1 Submitted $100,000.00
2 WW-PD-1 Waste Water Project 1 Submitted $500,000.00
$600,000.00
d + Name of C g ded for ded + P uID < Activity Type Status
2022-8899-DW-IP-1-
Concrete Co. PRO33566016 Procurement Approved
2022-8899-WW-PD-1-
Water Inc. PRO33566008 Procurement Approved
3lie 2022-8899-DW-IP-1- i
Drinking Water Company PRO33612276 Procurement Submitted

GENERAL INFORMATION

Total Committed =

$0.00

$0.00

$0.00

% Budget Amount + Committed Amount + Paid Amount + Remaining Amount +

$100,000.00

$500,000.00

$12,000.00

BUDGET AND ATTACHMENTS

]
> ®

GENERAL PROPOSAL INFI >

12012

Total Paid = Total Remaining  +
$0.00 $100,000.00
$0.00 $500,000.00
$0.00 $600,000.00

$0.00 $0.00 $100,000.00
$0.00 $0.00 $500,000.00
$1200n NN

NEXT >
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GMS Title VI Training Certification Process

Step 4: After the
activities page loads,
navigate to the Title VI
Training Certification
tab.

BN Brvoenants: Home ! T

Conservation

2022-8899 () Step 4 > ®

ARP COLLABORATIVE APPLICATION REVIEW TITLE VI TRAINING CERTIFICATION REQUEST BUDGET REVISIONS BUDGET ACCEPTANCE SUB-CONTRACTS REQUEST FOR GF >

B i= Default v 11 0f 1
lumns v x n Type All~  Status All ~

Step 5: Create a new
Title VI Training
Certification by
clicking the (+) button.

Activities

Form
Application . Activity » Report . - - . Last » Modified - . . » Receipt
O D S - ST + Organization = Application Type * Modified ° By % Status + CreatedBy = E:mpleted * Number
. DWR-ARP Collaborative

Title VI . . Test Test Test

[0 2022-8899 Training Sunshine, City  Grants State Water 02,/15/2023 Organization Draft Organization Organization
. . of Infrastructure Grants 03:25PM
Certification Contact 3 Contact 3 Contact 3
(SWIG) program

5/



GMS Title VI Training Certification Process: General Tab

Step 6: Navigate to the
General tab and click
“Download Title VI
Training Certification
Form” button to access
the certification form.

The form will then open
in a new pop-up
window.

BTN} Dopsctment o
Environment &

Conservation

2022-8899 ()

Grant > Activity

GENERAL ACTIVITY SUMMARY ACTIVITY COMMENTS

Tip: Be sure to frequently
click “Save Draft” to
ensure progress is not
lost

Activity Type: Title VI Training Certification
Status: Draft

Organization: Sunshine, City of
Title VI Training Certification
NOTE: The Title VI Training Certification only needs to be completed once per grant contract term.

The Tennessee Department of Environment and Conservation (TDEC) is a recipient of federal financial assistance. Recipients are required to comply with various nondiscrimination laws and regulations, including Title VI
of the Civil Rights Act of 1964, which bars discrimination on the basis of race, color, or national origin. The Civil Rights Restoration Act of 1987 clarifies that discrimination is prohibited throughout an entire agency if any
part of the agency receives federal financial assistance. As a sub-recipient of TDEC’s federal funds, you are required to comply with Title VI and related nondiscrimination laws and regulations.

Title VI regulations require sub-recipients to complete Title VI training; your entity must preserve class rosters or comparable evidence of periodic Title VI training for audit purposes. Below, the sub-recipient program
supervisor and its Title VI Coordinator (if a different person) must certify the date (within the last six months) of their completion of Title VI training, attach a copy of the class roster or certificate of completion from their
training, and certify that Title VI training is provided for staff, including new hires. Note: if Title VI Coordinator and Supervisor are the SAME PERSON, then only one signature and one evidence of training completion is
required.

As one acceptable means of completing Title VI training, your entity may use TDEC's Online Title VI Training Module video or powerpoint and retain Certificates of Completion for staff.

Download Title VI Training Certification Form

Step 6 l

1 and Dated Title VI Training Certification Form NEXT

> ®
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GMS Title VI Training Certification: Certification Form

Step 7: Download, print, and
complete the form. Once
completed, upload the form and
save the document on the
computer. Step 8 outlines the
process for uploading the form
into GMS.

Note: /f there is a Title VI
coordinator at your location, one
of the certificates of completion
must be for that individual.

DEPARTMENT OF ENVIRONMENT AND CONSERVATION
OFFICE OF POLICY AND PLANNING
William R. Snodgrass TN Tower
312 Rosa L. Parks Avenue, 2™ Floor
Nashville, TN 37243
TITLE VI TRAINING CERTIFICATION

Name of entity: Phone number:

Type of entity. (choose one): Government/Municipality D Private Business D Non-Profit D
Address:

City: State: Zip Code: County:

The Tennessee Department of Environment and Conservation (TDEC) is a recipient of federal financial assistance.
Recipients are required to comply with various nondiscrimination laws and regulations, including Title VI of the Civil
Rights Act of 1964, which bars discrimination on the basis of race, color, or national origin. The Civil Rights
Restoration Act of 1987 clarifies that discrimination is prohibited throughout an entire agency if any part of the agency
receives federal financial istance. As a sub-recipient of TDEC's federal funds, you are required to comply with Title
VI and related nondiscrimination laws and regulations.

Title VI regulations require sub-recipients to complete Title VI training; your entity must preserve class
rosters or comparable evidence of periodic Title VI training for audit purposes.

Below, the sub-recipient program supervisor and its Title VI Coordinator (if a different person) must certify
the date (within the last six months) of their completion of Title VI training, attach a copy of the class roster or
certificate of completion from their training, and certify that Title VI training is provided for staff, including
new hires.’

As one acceptable means of completing Title VI training, your entity may use TDEC's online Title VI training module:
https://tdec.tn.gov/title6/index.html and retain Certificates of Completion for staff.

Declaration of Sub-Recipient Title VI Coordinator: | completed Title VI training on (date), my entity
provides Title VI training for staff, including new hires, and to the best of my knowledge and belief the class roster
and/or certificates of completion for Title VI training attached are true, correct, and complete.

Printed Name and Title:

Signature: Date:

Declaration of Sub-Recipient Supervising Authority: | completed Title VI training on (date), my entity
provides Title VI training for staff, including new hires, and that the class roster and/or certificates of completion for
Title VI training attached are to the best of my knowledge and belief, true, accurate, and complete. | am aware that
there are significant penalties for submitting false information, including the possibility of fine and imprisonment. As
specified in Tennessee Code Sec. 39-16-702(a)(4), this declaration is made under penalty of perjury.

Printed Name and Title:

Signature: Date:
" If the sub. pient program super or its Title VI C is replaced during the contract term, the replacement must take Title VI training and
provide evidence of completion to the TDEC grant or loan administering program.
CN-1515 RDASW20 |
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GMS Title VI Training Certification: General Tab Cont.

Step 8: Click the upload
button (EX) to upload the [
signed and dated form.

Step 9: Enter the 2022-8899 () > ®
requested detalls In the GENERAL ACTIVITY SUMMARY ACTIVITY COMMENTS >

corresponding fields ]
confirming completion:

Upload Signed and Dated Title VI Training Certification Form

« Is the preliminary

I n fo rm atl O n CO m p | ete: Upload copies of the certificates of completion or other evidence of completion of Title VI training within the last six months by your entity's Title Vi Coordinator and Supervisor.

N a m e’ p h O n e n u m b e r’ Examples: Dated certificate of completion from TDEC or online Title VI training (TDOT, etc), statement from entity's HR stating that training was held on a specific date in the past six months and the specific person was in attendance.

type of entity, full
address?

« Did Title VI Coordinator
and Supervisor provide
title, signature, and date?

« Didthe Title VI
gggg?\i/?saotro anrr:]dp I ete T|t| e Examples: Dated certificate of completion from TDEC or online Title VI training (TDOT, etc), statement from entity's HR stating that training was held on a specific date in the past six months and the specific person was in at""‘r"l‘ég}")
VI training within the last
6 months and attach
evidence of that training 60
completion?

* |s the preliminary information complete: Name, phone number, type of entity, full address? | | Step 9

* Did Title VI Coordinator and Supervisor provide title, signature, and date? |

* Did the Title VI Coordinator and Supervisor complete Title VI training within the last 6 months and attach evidence of that training completion? |




GMS Title VI Training Certification: General Tab Cont.

Step 8: Click
the Submit TN S Home AT
button and the

certification will 2022-8899 () > ®
be SmeittEd tO GENERAL ACTIVITY SUMMARY

the TDEC team
for review

Upload Signed and Dated Title VI Training Certification Form

Upload copies of the certificates of completion or other evidence of completion of Title VI training within the last six months by your entity's Title Vi Coordinator and Supervisor.

ACTIVITY COMMENTS >

Examples: Dated certificate of completion from TDEC or online Title VI training (TDOT, etc), statement from entity’s HR stating that training was held on a specific date in the past six months and the specific person was in attendance.

* |s the preliminary information complete: Name, phone number, type of entity, full address?
* Did Title VI Coordinator and Supervisor provide title, signature, and date?

* Did the Title VI Coordinator and Supervisor complete Title VI training within the last 6 months and attach evidence of that training completion?

Examples: Dated certificate of completion from TDEC or online Title VI training (TDOT, etc), statement from entity’s H raining was held on a specific date in the past six months and the specific person was in at"‘“&*g;j{‘)
ep
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GMS Process for Uploading Deliverables

Step 1: Once logged in,
Navigate to the My
Applications tab and
click the Active tab.
Then, identify the grant
associated with the
deliverables activity.

Step 2: Select the
application and click
“View” to begin the
deliverables activity.

Current session: You are logged in as Sunshine, City of, to switch your organization click the Switch Organization button on the top right.

For Grants System Help, contact TDEC.Grants@tn.gov. For application questions, please contact the Grant Program Contact listed in the application.Note: 1t is recommended to use the Firefox browser while sccezsing the system for optimal performance.

| Procurement Guidelines

* Submit Affiliation Request How to Affiliate Tutorial

f Change Password

X Funding Opportunities +8
Frsers
Opportunity Details %

06/27/2023 03:53PM

06/27/2023 03:53PM

Material Management - Convenience Center Grant

Step 2 |

O 8 20228366 I

0O 9 20194854

DWR-ARP Non Collaborative Grants State Water Infrastructure Grants (SWIG) program Sunshine, City of Approved

Deadline: 07/01/2023

Deadline Passed DWR-ARP Non Collaborative Grants State Water Infrastructure Grants (SWIG) program Sunshine, City of Approved

RES Planning Grant Sunshine, City of Approved 06/13/2023 09:12AM

-

..* PENDING (0) O COMPLETED (0)

Material Management - Used Oil Grant

CUREMENTS (PENDING) (8

Deadline: 07/01/2023

Deadline Passed

# Application ID % Activity Type % Organization 4 Status £ LastModified ]

Mo matching records found

DWR-ARP Regionalization Grants State Water Infrastructure Grants (SWIG)

Deadline” 08/08/2023
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GMS Process for Uploading Deliverables

Step 3: Navigate to the

Manage Projects tab at
the top and scroll down “g5 p——p
to the Deliverables 20239039 (TEST) >©

ote MANAGE PROJECTS ~ PURPOSEAND OVERVIEW  TIMELINE ELIGIBILITY & FUNDING  SELECTIONCRITERIA  RESOURCES AND CONTACT  TITLEVICOMPLIANGE  GENERALINFORMATION  BUDGET AMD ATTACHMENTS ~ GENERAL PROPOSALINFO  PARTNER INFORMATION  INFRASTRUCTURE EXPENDIT >
. _
S e Ctl O n . ° m WVHP-1 test test IP-1-PRO34151127 Procurement Submitted §12,000.00 $12,000.00
m WWHIP-1 Greater than 50k [tem Greater than 50k Company NW-IP-1-PRO34191186 Procurement Approved $500,001.00 50.00 $0.00 $500,001.00
m WVHP-1 Less than 10k tem Less than 10k 2023-9039-WW-IP-1-PRO34191264 Pracurement Approved $10.00 $10.00
.

L]
° | C O n m WVHP-1 10k 10 50k tem 10k 1o 50k supplier IP-1-PRO34196333 Procurement Approved 5000 000
th e d e ive ra b | e to b e m WVHP-1 IP-1-PRO34225536 Pracurement Draft 50.00 50.00

$1,795517.00 51,060.00 $501,646.00 $1,292,811.00

uploaded.

Step 3 Deliverables

ot

Project ID Deliverable

“»

% DueDate + Status 3
Step 4 DW-PDC-1 Engineering Agreement 09/28/2023 Draft
open [ELITENE] Engineering plans and specifications 09/27/2023 Draft
m DW-PDC-1 Final Scorecard Summary 09/28/2023 Draft
m WW-IP-1 Anticipated Complete 03/14/2023 Draft
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GMS Process for Uploading Deliverables

Step 5: Fill in each
deliverable activity field -
(dates, etc.) and then
upload the deliverable
file.

Download Form Summary Relevant File(s): n

Step 5

Step 6: Click Save Draft
and then click Submit
to submit the
deliverable
documentation.

Size  Date

Step 6
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GMS Process for Uploading Deliverables

Step 7: Deliverable

revisions may be
requested. Grantees will |
receive an email 3 oo

requesting revisions and gz o
the accompanying
deliverable activity
status will change.

Step 8: Navigate to the
activity and open the
Notes tile on the left t( ser s
review additional details
on revisions needed.

1) 10/10/2023 02:49 PM
Type: Note to Grantee

Make revisions.

Note: Not all deliverables
will require revisions. If
the deliverable status is
approved, no further
action is needed.

B nn SortBy: Newestto Oldest

+ Due Date

10/10/2023

09/27/2023

aors

Step 7

> ®
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GMS Process for Uploading Deliverables

Step 9: To resubmit the
revised deliverable, fill in
the deliverable activity

Activity

fields with the updated = 3o
information and then e
upload the deliverable S
file. Click Save Draft
and then click Submit o
to submit the revised et
deliverable o e o
documentation. S
e _
e
Step 9

6/



GMS Process for Uploading Deliverables

Step 10: Grantees will

receive an email that

the deliverable has been
approved and the status
on the activity will
change to Approved. e ¢ oo : e :

DW-PDC-1 Engineering Agreement 1041042023 Step 10 Approved

m DW-PDC-1 Engineering plans and specifications 09/27/2023 Draft
m DW-PDC-1 Final Scorecard Summary 09/28/2023 Draft

WW-IP-1 Anticipated Complete 03/14/2023 Draft
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Process for Requesting Deliverables Support

= To contact the TDEC team
with a deliverables issue,
click the Notes tile located
on the toolbar to the left.

= (Click the (+) button and a
pop-up window will open.

= Select“Note to TDEC”
from the Type drop-down
menu. Enter any question
or comment for the TDEC
team in this text field.

= Upon saving the message,
the system will notify the
TDEC team. The TDEC
team will then review and
respond to the inquiry.

GMS will alert the inquirer
of a response via email.

Activity

Type: —all— | From: | mmy/dd/yyyy To:| mmy/dd/yyyy n n Sort By:
No Records Found
Activity
Type: | Noteto TDEC ~
3 Notes
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GMS Process for Requesting Site Inspections

Step 1: Once logged in,
Navigate to the My
Applications tab and
click the Active tab.
Then, identify the grant
associated with the site
inspections activity.

Step 2: Select the
application and click
“View” to begin the Site
Inspections activity.

Current session: You are logged in as Sunshine, City of, to switch your organization click the Switch Organization button on the top right.

For Grants System Help, contact TDEC.Grants@tn.gov. For application questions, please contact the Grant Program Contact listed in the application.Note: 1t is recommended to use the Firefox browser while sccezsing the system for optimal performance.

| Procurement Guidelines

* Submit Affiliation Request How to Affiliate Tutorial

f Change Password

X Funding Opportunities +8
Frsers
Opportunity Details %

06/27/2023 03:53PM

06/27/2023 03:53PM

Material Management - Convenience Center Grant

Step 2 |

O 8 20228366 I

0O 9 20194854

DWR-ARP Non Collaborative Grants State Water Infrastructure Grants (SWIG) program Sunshine, City of Approved

Deadline: 07/01/2023

Deadline Passed DWR-ARP Non Collaborative Grants State Water Infrastructure Grants (SWIG) program Sunshine, City of Approved

RES Planning Grant Sunshine, City of Approved 06/13/2023 09:12AM

-

* PENDING (0) O COMPLETED (0)

Material Management - Used Oil Grant

CUREMENTS (PENDING) (8

Deadline: 07/01/2023

Deadline Passed

# Application ID % Activity Type % Organization 4 Status £ LastModified ]

Mo matching records found

DWR-ARP Regionalization Grants State Water Infrastructure Grants (SWIG)

Deadline” 08/08/2023

/1



GMS Process for Requestin

g Site Inspections

Step 3: Navigate to the
Manage Projects tab
and scroll down to the

Site Inspections
section.

Step 4: Click Open on
the site inspection to be

uploaded.

2023-9039 (TEST)
MANAGE PROJECTS PURPOSE

m WWHIP-1
m WWHP-1
m WW-IP-1
m WW-IP-1
[ open |

WW-P-1

Project ID

DW-PDC-1
DW-PDC-1
DW-PDC-1

WW-IP-1

Step 3

Site Inspections]

Step 4

Site Inspection Type

Initiation of Operations

AND OVERVIEW TIMELINE

test

Greater than 50k item

Less than 10k ltem

10k to 50k Item

ELIGIBILITY & FUNDING SELECTION CRITERIA RESOURCE

test

Greater than 50k Company

Less than 10k

10k 1o 50k supplier

Deliverable

Engineering Agreement

Engineering plans and specifications

Final Scorecard Summary

Anticipated Complete

% Project D %+ Project Name

DW-PDC-1 Water Lines - Test

AND CONTACT TITLE VI COMPLIANCE

2023-9039-WW-P-1-PRO34191127

2023-9039-WWHP-1-PRO34191186

2023-9039-WW-IP-1-PR0O34191264

2023-9039-WW-IP-1-PR0O34196333

2023-9039-WWHP-1-PRO34225536

% Project Type

AL IN

JRMATION

Procurement

Procurement

Procurement

Procurement

Procurement

Planning, Design, and Construction

BUDGET AND AT

Submitted

Approved

Approved

Approved

Draft

A

§12,000.00

$500,001.00

$10.00

$0.00

50.00

§1,795517.00

Due Date

10/10/2023

09/27/2023

09/28/2023

03/14/2023

ACHMENTS GENERAL PROPOSAL

NFO

$0.00

$1,060.00

Permits

Select One

PARTNER

Status

>orL

INFRASTRUCTUR

$12,000.00

$0.00 $500,001.00
$10.00

$0.00

$0.00

5§501,646.00 $1,292,811.00

acts

Approved

Draft

Draft

Draft

e

+ Status =

Draft

/2



GMS Process for Requesting Site Inspections

Step 5: Fill in the Site Activity
Inspection Request

@ Main
a CtIVIty fl e | d S . B Notes Step 5 Relevant File(s): H

SITE INSPECTION REQUEST

Project > Activity

* Site Inspection Type

Step 6: Click Save Draft
and then click Submit
to submit the Site
Inspection activity.

Initiation of Operations e

* Street Address

State

TH

* City

* County

* Zip Code

* Requested Date of Site Inspection

10/19/2023 =]

* Phone Number of responsible on-site personnel during site inspection

* Does the construction project have either an ARAP or General Construction permit?

Select One W

Step 6

[oveoe | s

/3



GMS Process for Checking Site Inspection Status

Step 7: Once submitted,
the grantee will receive a
confirmation email of a
Site inspection request
and hear back from the
TDEC team with further
instructions.

Note: Within the Site
Inspections section, the
grantee can see the status
of each Site Inspection (ex.
Site Inspection Requested,
Site Inspection Scheduled,
Site Inspection Not Needed,
Site Inspection Complete,
Site Inspection Complete:
Issues with Inspection)

Site Inspections

0 Site Inspection Type

| m Initiation of Operations

+ ProjectID

WW-IPD-1

DW-P-1

WW-IPD-1

DW-P-1

WW-IPD-1

= Project Name

\Waste Water Project 1

Project 1

\Waste Water Project 1

Project 1

\Waste Water Project 1

= Project Type

Investigation, Planning, and Design

Investigation and Planning

Investigation, Planning, and Design

Investigation and Planning

Investigation, Planning, and Design

+ Pemmits

Yes

Yes

Yes

No

Yes

+ Status

Draft

Site Inspection Scheduled
Site Inspection Requested
Site Inspection Not Needed

Site Inspection Complete: Issues with Inspection

74



Process for Requesting Site Inspections Support

= To contact the TDEC team Activity
with a site inspection

issue, click the Notes tile
located on the toolbar to
the left.

= (Click the (+) button and a
pop-up window will open.

= Select “Note to TDEC”
from the Type drop-down
menu. Enter any question

Project » Activity

Type: —all— | From: | mmy/dd/yyyy To:| mmy/dd/yyyy n n Sort By:

No Records Found

or comment for the TDEC
team in this text field. Activity
= Upon saving the message, | Actions » |
the system will notify the m Project > Activity
TDEC team. The TDEC Type: [Nore o T0EG <
team will then review and 3 Notes

respond to the inquiry.

=  GMS will alert the inquirer
of a response via email.
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Additional Resources

= Additional guidance relevant to the State Water Infrastructure Grants program and Grants
Management System is located on the TDEC ARP website.

= Included below are links to some of the most relevant resources as grantees navigate the
procurement and reimbursement processes:

« ARP Grant Implementation Guide

« About the Grants Management System

- System for Award Management (SAM or sam.gov)

= Questions about GMS, procurement or reimbursement processes and guidelines should be

directed to tdec.arp@tn.gov. System related questions or issues should be directed to
tdec.grants@tn.gov.
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https://www.tn.gov/environment/arp.html
https://www.tn.gov/content/dam/tn/environment/arp/documents/arp_implementation-guide.pdf
https://www.tn.gov/environment/about-tdec/grants/program-areas.html
https://sam.gov/content/home
mailto:tdec.grants@tn.gov

